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2 Getting Started with the Application

To develop a Java application that connects to Oracle Database XE, you must ensure that certain components are installed as required. This chapter covers the following topics:

	
What You Need to Install


	
Verifying the Oracle Database XE Installation


	
Installing Oracle JDeveloper






2.1 What You Need to Install

To be able to develop the sample application, you need to install the following products and components:

	
Oracle Database XE


	
J2SE or JDK


	
Integrated Development Environment


	
Web Server




The following subsections describe these requirements in detail.



2.1.1 Oracle Database XE

To develop the Java application, you need a working installation of Oracle Database XE Server with the HR schema, which comes with the database. The installation creates an instance of Oracle Database XE and provides additional tools for managing this database. For more information, refer to the following Oracle Database XE installation guides and release notes:

	
Oracle Database Express Edition Installation Guide for Linux x86-64


	
Oracle Database Express Edition Installation Guide for Microsoft Windows






2.1.1.1 Modifying the HR Schema for the JDBC Application

The HR user account, which owns the sample HR schema used for the Java application in this guide, is initially locked. You must log in as a user with administrative privileges (SYS) and unlock the account before you can log in as HR.

If the database is locally installed, use the Run SQL Command Line to unlock the account as follows:

	
To access the Run SQL Command Line, from the Start menu, select Programs (or All Programs), then Oracle Database 11g Express Edition, and then click Run SQL Command Line. Log in as a user with DBA privileges, for example:


> CONNECT SYS AS SYSDBA;
Enter password: password


	
Run the following command:


> ALTER USER HR ACCOUNT UNLOCK;


or,


> ALTER USER HR IDENTIFIED BY HR;


	
Test the connection as follows:


> CONNECT HR
Enter password: password




You should see a message indicating that you have connected to the database.




	
Note:

For information about creating and using secure passwords with Oracle Database XE, refer to Oracle Database Security Guide.







In addition, some of the constraints and triggers present in the HR schema are not in line with the scope of the Java application created in this guide. You must remove these constraints and triggers as follows using the following SQL statements:


DROP TRIGGER HR.UPDATE_JOB_HISTORY;
DROP TRIGGER HR.SECURE_EMPLOYEES;
DELETE FROM JOB_HISTORY;








2.1.2 J2SE or JDK

To create and compile Java applications, you need the full Java 2 Platform, Standard Edition, Software Development Kit (J2SE SDK), formerly known as the Java Development Kit (JDK). You also need the Java Runtime Environment (JRE).




	
Note:

	
Oracle Database XE does not support JDK 1.2, JDK 1.3, JDK 1.4, and all classes12*.* files. The oracle.jdbc.driver.* classes, the ojdbc4.jar file, and the OracleConnectionCacheImpl class are no longer supported or available.


	
You must use the ojdbc5.jar and the ojbc6.jar files with JDK 5.n and JDK 6.n, respectively.















	
See Also:

	http://www.oracle.com/technetwork/java/javase/downloads/index.html for information about installing Java
	
http://www.oracle.com/technetwork/java/overview-141217.html for information about the JDBC API

















2.1.3 Integrated Development Environment

For ease in developing the application, you can choose to develop your application in an integrated development environment (IDE). This guide uses Oracle JDeveloper to create the files for this application. For more information about installing JDeveloper, refer to Installing Oracle JDeveloper.






2.1.4 Web Server

The sample application developed in this guide uses JavaServer Pages (JSP) technology to display information and accept input from users. To deploy these pages, you need a Web server with a servlet and JSP container, such as the Apache Tomcat application server.

This guide uses the embedded server called the Oracle WebLogic Server in JDeveloper for deploying the JSP pages. If you choose not to install Oracle JDeveloper, then any Web server that enables you to deploy JSP pages should suffice.

JDeveloper supports direct deployment to the following production application servers:

	
Oracle WebLogic Server


	
Oracle Application Server


	
Apache Tomcat


	
IBM WebSphere


	
JBoss




For more information about these servers, please refer to vendor-specific documentation.








2.2 Verifying the Oracle Database XE Installation

Oracle Database XE installation is platform-specific. You must verify that the installation was successful before you proceed to create the sample application. This section describes the steps for verifying an Oracle Database XE installation.

Verifying a installation involves the following tasks:

	
Checking Installed Directories and Files


	
Checking the Environment Variables


	
Determining the JDBC Driver Version






2.2.1 Checking Installed Directories and Files

Installing Oracle Java products creates the following directories:

	
ORACLE_HOME/jdbc


	
ORACLE_HOME /jlib




Check if the directories described in Table 2-1 have been created and populated in the ORACLE_HOME directory.


Table 2-1 Directories and Files in the ORACLE_HOME Directory

	Directory	Description
	
/jdbc/lib

	
The lib directory contains the ojdbc5.jar and ojdbc6.jar required Java classes. These contain the JDBC driver classes for use with JDK 5 and JDK 6.


	
/jdbc/Readme.txt

	
This file contains late-breaking and release-specific information about the drivers, which may not have been included in other documentation on the product.


	
/jlib

	
This directory contains the orai18n.jar file. This file contains classes for globalization and multibyte character sets support.











	
Note:

These files can also be obtained from the Sun Microsystems Web site. However, it is recommended to use the files supplied by Oracle, which have been tested with the Oracle drivers.












2.2.2 Checking the Environment Variables

This section describes the environment variables that must be set for the JDBC Thin Driver. You must set the classpath for your installed JDBC Thin Driver. For JDK 5, you must set the following values for the CLASSPATH variable:



ORACLE_HOME/jdbc/lib/ojdbc5.jar

ORACLE_HOME/jlib/orai18n.jar

For JDK 6, you must set the following values for the CLASSPATH variable:



ORACLE_HOME/jdbc/lib/ojdbc6.jar

ORACLE_HOME/jlib/orai18n.jar

Ensure that there is only one JDBC class file, such as ojdbc6.jar, and one globalization classes file, orai18n.jar, in the CLASSPATH variable.






2.2.3 Determining the JDBC Driver Version

Starting from Oracle Database XE 11g Release 2, you can get details about the JDBC support in the database as follows:


> java -jar ojdbc6.jar
  Oracle 11.1.0.0. JDBC 4.0 compiled with JDK6


In addition, you can determine the version of the JDBC driver that you installed by calling the getDriverVersion method of the OracleDatabaseMetaData class.




	
Note:

The JDBC Thin Driver requires a TCP/IP listener to be running on the computer where the database is installed.







Example 2-1 illustrates how to determine the driver version:


Example 2-1 Determining the JDBC Driver Version


import java.sql.*;
import oracle.jdbc.*;
import oracle.jdbc.pool.OracleDataSource;

class JDBCVersion
{
  public static void main (String args[]) throws SQLException
  {
    OracleDataSource ods = new OracleDataSource();
    ods.setURL("jdbc:oracle:thin:hr/hr@localhost:1521/XE");
    Connection conn = ods.getConnection();

    // Create Oracle DatabaseMetaData object
    DatabaseMetaData meta = conn.getMetaData();

    // gets driver info:
    System.out.println("JDBC driver version is " + meta.getDriverVersion());
  }
}










2.3 Installing Oracle JDeveloper

In this guide, the integrated development environment (IDE) that is used to create the sample Java application using JDBC is Oracle JDeveloper release 11.1.1. This release of JDeveloper is supported on the Microsoft Windows Vista, Windows XP, Windows 2003, Windows 2000, Linux, and Mac OS X operating systems. Installation of JDeveloper is described in detail in Installation Guide for Oracle JDeveloper Release 11.1.1.0.0, which is available online on the Oracle Technology Network at

http://download.oracle.com/docs/cd/E12839_01/install.1111/e13666/toc.htm

This guide gives a detailed description of the JDeveloper system requirements, and all the details about installing JDeveloper on the supported platforms. You should also read JDeveloper 11g Release Notes, which is available online on the Oracle Technology Network at

http://www.oracle.com/technetwork/developer-tools/jdev/overview/index.html


2.3.1 JDeveloper Studio Edition: Base Installation and Full Installation

JDeveloper 11.1.1 is available in two editions. The Studio Edition includes Oracle ADF, which is required for developing the master-detail application created in this guide.

You can install either the base installation or the full installation of the JDeveloper Studio Edition. In addition to JDeveloper, the full installation includes the required version of Java, the specialized Oracle Java Virtual Machine for JDeveloper (OJVM), and the online documentation, so the download file size is larger. For quicker downloading, you can install the JDeveloper base installation.





2.3.2 Steps to Install JDeveloper

If you are installing the base installation, you must have J2EE version 1.6.0_05 on your system. If you are installing the full installation, then J2EE is included. In outline, the installation process is as follows:

	
Download JDeveloper version 11.1.1 Studio Edition from the Oracle Technology Network at

http://www.oracle.com/technetwork/developer-tools/jdev/downloads/index.html

Download the base installation (jdevjavabase11110.zip), or the full installation (jdevstudio11110install.exe). It is recommended that you download the Studio Edition to avail all features.


	
To launch the installer for the base installation, enter the following command at the command line:

java -jar jdevstudio11110install.jar

To launch the installer for the full installation, double click jdevstudio11110install.exe and follow the instructions.




	
Note:

When choosing the Middleware Home directory, ensure that you choose a directory that does not contain spaces. For example, do not use C:\Program Files as the Middleware Home.







To change a JDK location that you have previously specified, you have to modify the jdev.conf file. Set the variable SetJavaHome in the file <install_dir>/jdeveloper/jdev/bin/jdev.conf to the location of your Java installation. Here, Middleware Home directory has been represented by <install_dir>.For example, in a UNIX environment, if the location of your JDK is in a directory called /usr/local/java, your entry in jdev.conf would be as follows:

SetJavaHome /usr/local/java

Other tasks that you must perform include setting the permissions for all JDeveloper files to read, and giving all users write and execute permissions to files in a range of JDeveloper directories.


	
If you are using the base installation, there are some additional setup tasks, such as setting the location of your Java installation in the JDeveloper configuration file, optionally installing OJVM, and downloading the online documentation so that it is locally available.







	
See Also:

http://download.oracle.com/docs/cd/E12839_01/install.1111/e13666/toc.htm for the JDeveloper Installation Guide











2.3.3 Starting JDeveloper

To start JDeveloper on Windows, click Start, select All Programs, then select Oracle Fusion Middleware 11.1.1.4.0 and select JDeveloper Studio 11.1.1.4.0. You can also run the <install_dir>\jdeveloper\jdev\bin\jdevw.exe file. To use a console window for displaying internal diagnostic information, run the jdev.exe file in the same directory instead of jdevw.exe.

To start JDeveloper on other platforms, run the <install_dir>/jdeveloper/jdev/bin/jdev file.














3 Connecting to Oracle Database XE

This chapter is the first in a series of five chapters, each of which describes how to create parts of a Java application that accesses Oracle Database XE and displays, modifies, deletes, and updates data on it. To be able to access the database from a Java application, you must connect to the database using a java.sql.Connection object.

This chapter includes the following sections:

	
Connecting to Oracle Database XE from JDeveloper


	
Setting Up Applications and Projects in JDeveloper


	
Connecting to Oracle Database XE from a Java Application






3.1 Connecting to Oracle Database XE from JDeveloper

You can set up and manage database connections in JDeveloper to enable your application to communicate with external data sources, including Oracle Database XE and offline database objects. This is done using the Database Navigator. The same navigator is also used to manage other connections your application needs, such as connections to application servers. The following subsections describe how you can use the Database Navigator to view the database and its objects and to create a connection to the database:

	
JDeveloper Database Navigator


	
Creating a Database Connection


	
Browsing the Data Using the Database Navigator






3.1.1 JDeveloper Database Navigator

The Database Navigator displays all currently defined connections. To view the Database Navigator, select the Database Navigator tab in the navigator panel on the top left-hand side of the JDeveloper display, if it is displayed, or use the View menu. For an illustration of the default layout of the JDeveloper IDE, see Figure 1-1.

You can use the Database Navigator to browse through the connections it displays. In particular, for a database schema, you can also view database objects, tables, views, and their contents.

Database connections are shown under the IDE Connections node. To view the objects in the database, expand the connection. Expanding a schema displays nodes for the object types in that schema. Expanding the node for an object type displays its individual objects. When you expand a table node, you can view the structure of the table and the data within the table.






3.1.2 Creating a Database Connection

You can connect to any database for which you have connection details. When you create a database connection, you must specify a user name and a password. By default, the connection enables you to browse only the schema of the user that you specify in the connection.

To create a connection, follow these steps:

	
Start JDeveloper.


	
From the View menu, go to Database and select Database Navigator. The Database Navigator is displayed, showing you a list of available connections.


	
Right-click IDE Connection, and from the shortcut menu, select New Connection. The Create Database Connection screen is displayed.


	
On the Create Database Connection screen, do not change the default values for the connection name and type, Connection1 and Oracle (JDBC). Enter HR in both the Username and Password fields. Do not enter a value for Role, and select Deploy Password. You must provide information about the computer where your database is located. Your database administrator should provide you with this information.

Enter the following information:

	
Driver: thin


	
Host Name: Host name of the computer where Oracle Database XE is installed

If the database is on the same computer, then for the Host Name parameter, enter localhost.


	
JDBC Port: 1521


	
SID: XE




Click Test Connection. If the connection is successful, the word Success! is displayed in the Status field.

Figure 3–1 shows the Connection screen where you enter these details.


Figure 3-1 Specifying Connection Details

[image: Description of Figure 3-1 follows]





	
Click Finish to create the connection and close the screen.





Disconnecting and Reconnecting from Oracle Database XE in JDeveloper

To disconnect from the database in JDeveloper, in the Database Navigator, right-click the connection name and select Disconnect. The display in the Database Navigator now shows only the name of the connection, without the plus (+) symbol for expanding the node. To reconnect to the database, right-click the connection name and select Connect.






3.1.3 Browsing the Data Using the Database Navigator

After you have successfully established a connection to the database, you can browse its contents through the Database Navigator. The Database Navigator displays a navigable, hierarchical tree structure for the database, its objects, their instances, and the contents of each. To view the contents at each level of the hierarchy of the database connection that you created, do the following:

	
The IDE Connections node in the Database Navigator now shows a node with the name of your connection. Click the plus symbol (+) to the left of the connection name to expand the navigation tree. To display a list of the instances of an object type, for example Tables, expand the Table navigation tree.


	
The Structure window below the navigator shows the detailed structure of any object selected in the navigator. Select a table in the navigator (for example Employees) to see the columns of that table in the Structure window.


	

Figure 3-2 Viewing the Table Structure and Data

[image: Description of Figure 3-2 follows]





	
If you double-click a table in the navigator, the structure of that table is displayed in the main editing area of the window. It includes details about all the columns, such as Name, Type, and Size, so you can browse the table definition.

To view the data from a table, select the Data tab below the table structure. You can now view and browse through the table data.


	
You can also edit the objects in the Database Navigator. To edit a table, right-click the table and select Edit from the shortcut menu. A dialog box enables you to make changes to the selected table.











3.2 Setting Up Applications and Projects in JDeveloper

In JDeveloper, you create your work in an application, within which you can organize your work into a number of projects. JDeveloper provides a number of application templates, to help you to create the project structure for standard types of application relatively quickly and easily. At the time you create your application in JDeveloper, you can choose the application template that matches the type of application you will be building.

The application template you select determines the initial project structure (the named project folders within the application) and the application technologies that will be included. You can then add any extra libraries or technologies you need for your particular application, and create additional projects if you need them.


3.2.1 Using the JDeveloper Application Navigator

The Application Navigator displays all your applications and projects. When you first start JDeveloper, the Application Navigator is displayed by default on the left side of the JDeveloper IDE.

To view the Application Navigator when it is not displayed, you can click the Applications tab in the navigator panel on the top left-hand side of the JDeveloper display, or select Application Navigator from the View menu.

The Application Navigator shows a logical grouping of the items in your projects. To see the structure of an individual item, you can select it and the structure is displayed in the Structure window.

From the Application Navigator, you can display items in an appropriate default editor. For example, if you double-click a Java file, the file opens in the Java Source Editor, and if you double-click a JavaServer Pages (JSP) file, it opens in the JSP/HTML Visual Editor.





3.2.2 Creating an Application and a Project

To get started with JDeveloper, you must create an application and at least one project in which to store your work, as follows:

	
In the Application Navigator, click New Application.


	
The Create Generic Application wizard is displayed. In the Name your application screen, enter HRApp in the Application Name field, and from the Application Template list, select Generic Application. Click Next.


	
On the Name your project screen, enter View as the name of the project. Click Finish.


	
The new HRApp application is displayed in the Application Navigator.


	
Save your application. To do this, from the File menu, select Save All.








3.2.3 Viewing the Javadoc and Source Code Available in the Project Scope

You can view the Javadoc or the code for any of the classes available in the project technology scope within JDeveloper. In addition, you can view the details of all the methods available for those classes.

For example, to see the code or Javadoc for the Connection class, do the following:

	
With your project selected in the Application Navigator, from the Navigate menu select Go to Java Type. You can also do this for a specific file in your project.


	
In the Go to Java Type dialog box, type the name of the Java class.


	
Enter the name of the class you want to view in the Name field, or click Browse to find the class. For the Connection class, start to enter Connection, and from the displayed list select Connection (java.sql).


Figure 3-3 Selecting the Class to View the Javadoc in JDeveloper

[image: Description of Figure 3-3 follows]





	
Click OK.











3.3 Connecting to Oracle Database XE from a Java Application

So far, you have seen how to connect to the database from JDeveloper. To initiate a connection from the Java application, you use the Connection object from the JDBC application programming interface (API).

This section describes connecting to the database from the Java application in the following subsections:

	
Overview of Connecting to Oracle Database XE


	
Specifying Database URLs


	
Creating a Java Class in JDeveloper


	
Java Libraries


	
Adding JDBC and JSP Libraries


	
Importing JDBC Packages


	
Declaring Connection-Related Variables


	
Creating the Connection Method






3.3.1 Overview of Connecting to Oracle Database XE

In Java, you use an instance of the DataSource object to get a connection to the database. The DataSource interface provides a complete replacement for the previous JDBC DriverManager class. Oracle implements the javax.sql.DataSource interface with the OracleDataSource class in the oracle.jdbc.pool package. The overloaded getConnection method returns a physical connection to the database.




	
Note:

The use of the DriverManager class to establish a connection to a database is deprecated.







You can either set properties using appropriate setxxx methods for the DataSource object or use the getConnection method that accepts these properties as input parameters.

Important DataSource Properties are listed in Table 3-1.


Table 3-1 Standard Data Source Properties

	Name	Type	Description
	
databaseName

	
String

	
Name of the particular database on the server. Also known as the service name (or SID) in Oracle terminology. For Oracle Database XE, this is XE by default.


	
dataSourceName

	
String

	
Name of the underlying data source class.


	
description

	
String

	
Description of the data source.


	
networkProtocol

	
String

	
Network protocol for communicating with the server. For Oracle, this applies only to the JDBC Oracle Call Interface (OCI) drivers and defaults to tcp.


	
password

	
String

	
Password for the connecting user.


	
portNumber

	
int

	
Number of the port where the server listens for requests


	
serverName

	
String

	
Name of the database server


	
user

	
String

	
User name to be used for login


	
driverType

	
String

	
Specifies the Oracle JDBC driver type. It can be either oci or thin.

This is an Oracle-specific property.


	
url

	
String

	
Specifies the URL of the database connect string.You can use this property in place of the standard portNumber, networkProtocol, serverName, and databaseName properties.

This is an Oracle-specific property.








If you choose to set the url property of the DataSource object with all necessary parameters, then you can connect to the database without setting any other properties or specifying any additional parameters with the getDBConnection method. For more information about setting the database URL, refer to the Specifying Database URLs section.




	
Note:

The parameters specified through the getConnection method override all property and url parameter settings previously specified in the application.












3.3.2 Specifying Database URLs

This release of Oracle JVM supports Internet Protocol Version 6 (IPv6) addresses in the URL and system names of the Java code in the database, which resolve to IPv6 addresses.

Database URLs are strings that you specify for the value of the url property of the DataSource object. The complete URL syntax is the following:


jdbc:oracle:driver_type:[username/password]@database_specifier


The first part of the URL specifies which JDBC driver is to be used. The supported driver_type values for client-side applications are thin and oci. The brackets indicate that the user name and password pair is optional. The database_specifier value identifies the database to which the application is connected.

The following is the syntax for thin-style service names that are supported by the Thin driver:

jdbc:oracle:driver_type:[username/password]@//host_name:port_number:SID

For the sample application created in this guide, if you include the user name and password, and if the database is hosted locally, then the database connection URL is as shown in Example 3-1.


Example 3-1 Specifying the url Property for the DataSource Object


jdbc:oracle:thin:hr/hr@localhost:1521:XE





3.3.2.1 Using the Default Service Feature of the Oracle Database XE

If you have performed Oracle Database server installation in Typical mode, then the default service name used by the Oracle instance is ORCL, and the following Easy Connect syntax can be used to connect to that instance:


sqlplus /nolog
SQL> CONNECT username@"host/ORCL"
SQL> Enter password: password


The Easy Connect feature, which was introduced in Oracle Database 11g Release 1 (11.1), makes the following parts of the conventional JDBC connection URL syntax optional:

jdbc:oracle:driver_type:[username/password]@[//]host_name[:port][:XE]

In this URL:

	
// is optional.


	
:port is optional.

Specify a port only if the default Oracle Net listener port (1521) is not used.


	
:XE (or the service name) is optional.

The connection adapter for the Oracle Database connects to the default service on the host. On the host, this is set to XE in the listener.ora file.







	
See Also:

Oracle Database Net Services Administrator's Guide for more information about the Easy Connect feature







Example 3-2 shows a basic configuration of the listener.ora file, where the default service is defined.


Example 3-2 Default Service Configuration in listener.ora


MYLISTENER = (ADDRESS_LIST= 
 (ADDRESS=(PROTOCOL=tcp)(HOST=test555)(PORT=1521)) 
) 
DEFAULT_SERVICE_MYLISTENER=dbjf.regress.rdbms.dev.testserver.com
 
SID_LIST_MYLISTENER = (SID_LIST=
(SID_DESC=(SID_NAME=dbjf)(GLOBAL_DBNAME=dbjf.regress.rdbms.dev.testserver.com)(ORACLE_HOME=/test/oracle)) 
)




After making changes to the listener.ora file, you must restart the listener with the following command:


> lsnrctl start mylistener


The following URLs should work with this configuration:


jdbc:oracle:thin:@//test555.testserver.com
jdbc:oracle:thin:@//test555.testserver.com:1521
jdbc:oracle:thin:@test555.testserver.com
jdbc:oracle:thin:@test555.testserver.com:1521
jdbc:oracle:thin:@(DESCRIPTION=(ADDRESS=(PROTOCOL=TCP)(HOST=test555.testserver.com)(PORT=1521)))
jdbc:oracle:thin:@(DESCRIPTION=(ADDRESS=(PROTOCOL=TCP)(HOST=test555.testserver.com)))
jdbc:oracle:thin:@(DESCRIPTION=(ADDRESS=(PROTOCOL=TCP)(HOST=test555.testserver.com)(PORT=1521))(CONNECT_DATA=(SERVICE_NAME=)))





	
Note:

Default service is a new feature in Oracle Database XE 11g Release 2. If you use any other version of the Oracle Database to connect to the database, then you must specify the SID and port number.














3.3.3 Creating a Java Class in JDeveloper

The first step in building a Java application is to create a Java class. The following instructions describe how you create a class called DataHandler, which will contain the methods for querying the database and modifying the data in it.

	
In the Application Navigator, right-click the View project, and from the shortcut menu, select New.


	
In the New Gallery dialog box, select General in the Categories list. In the Items list, select Java Class, and click OK. The Create Java Class dialog box is displayed.


	
In the Create Java Class dialog box, enter DataHandler in the Name text box, and hr in the Package text box. Do not change the default values of the Optional Attributes, and click OK. The Create Java Class dialog box with the appropriate values specified is shown in Figure 3-4.


Figure 3-4 Creating a Java Class

[image: Description of Figure 3-4 follows]





	
The skeleton DataHandler class is created and is displayed in the Java Source Editor. The package declaration, the class declaration, and the default constructor are created by default. Figure 3-5 shows the class displayed in the Java Source Editor, ready for you to add your Java code:


Figure 3-5 Java Source Editor

[image: Description of Figure 3-5 follows]












3.3.4 Java Libraries

Oracle JDeveloper comes with standard libraries to help Java application programming. These libraries include API support for Application Development Framework (ADF), Oracle libraries for JDBC, JSP, and so on.

To use JDBC in your project, you import the Oracle JDBC library into the project. Similarly, to use JSP technology, you import the JSP Runtime library.


3.3.4.1 Overview of the Oracle JDBC Library

Important packages of the Oracle JDBC library include the following:

	
oracle.jdbc: The interfaces of the oracle.jdbc package define the Oracle extensions to the interfaces in the java.sql package. These extensions provide access to Oracle SQL-format data and other Oracle-specific features, including Oracle performance enhancements.


	
oracle.sql: The oracle.sql package supports direct access to data in SQL format. This package consists primarily of classes that provide Java mappings to SQL data types and their support classes.


	
oracle.jdbc.pool: This package includes the OracleDataSource class that is used to get a connection to the database. The overloaded getConnection method returns a physical connection to the database.








3.3.4.2 Overview of the JSP Runtime Library

This library includes the classes and tag libraries required to interpret and run JSP files on the Oracle WebLogic Server that comes with JDeveloper.








3.3.5 Adding JDBC and JSP Libraries

To include libraries in your project, perform the following steps:

	
Double-click the View project in the Application Navigator to display the Project Properties dialog box.


	
Click Libraries and Classpath, and then click Add Library.... The Add Library dialog box is displayed with a list of the available libraries for the Java2 Platform, Standard Edition (J2SE) version is displayed.


	
In the Add Library dialog box, scroll through the list of libraries in the Extension folder. Select JSP Runtime library and click OK to add it to the list of selected libraries for your project. Similarly, add the Oracle JDBC library. Figure 3-6 shows the Oracle JDBC library added to the View project.


Figure 3-6 Importing Libraries

[image: Description of Figure 3-6 follows]





	
Click OK.









3.3.6 Importing JDBC Packages

To use JDBC in the Java application, import the following JDBC packages:

	
If the DataHandler.java class is not already open in the Java Source Editor, in the Application Navigator, expand the View project, Application Sources, and your package (hr) and double-click DataHandler.java.


	
At the end of the generated package declaration, on a new line, enter the import statements shown in Example 3-3.





Example 3-3 Importing Packages in a Java Application


package hr;
import java.sql.Connection;
import oracle.jdbc.pool.OracleDataSource;








3.3.7 Declaring Connection-Related Variables

Connection information is passed to the connection method by using the following connection variables: the connection URL, a user name, and the corresponding password.

Use the Java Source Editor of JDeveloper to edit the DataHandler.java class as follows:

	
After the DataHandler constructor, on a new line, declare the three connection variables as follows:


String jdbcUrl = null;
String userid = null;
String password = null; 


These variables will be used in the application to contain values supplied by the user at login to authenticate the user and to create a connection to the database. The jdbcUrl variable is used to hold the URL of the database that you will connect to. The userid and password variables are used to authenticate the user and identify the schema to be used for the session.




	
Note:

The login variables have been set to null to secure the application. At this point in the guide, application login functionality is yet to be built into the application. Therefore, to test the application until login functionality is built in, you can set values in the login variables as follows:
Set the jdbcUrl variable to the connect string for your database.


String jdbcUrl = "jdbc:oracle:thin:@localhost:1521:XE";


Set the variables userid and password to hr as follows:


String userid = "hr";
String password = "hr";


Make sure you reset these to null as soon as you finish testing.

For more information about security features and practices, refer to Oracle Database Security Guide and the vendor-specific documentation for your development environment.










	
On a new line, declare a connection instance as follows:


Connection conn;


Your Java class should now contain the code in Example 3-4.


Example 3-4 Declaring Connection Variables and the Connection Object


package hr;
import java.sql.Connection;
import oracle.jdbc.pool.OracleDataSource;
 
public class DataHandler {
    public DataHandler() {
    }
    String jdbcUrl = null;
    String userid = null;
    String password = null; 
    Connection conn;
}











3.3.8 Creating the Connection Method

To connect to the database, you must create a method as follows:

	
Add the following method declaration after the connection declaration:


public void getDBConnection() throws SQLException


The Java Code Insight feature displays a message reminding you to import the SQLException error handling package. Press the Alt+Enter keys to import it. The import java.sql.SQLException statement is added to the list of import packages.


	
At the end of the same line, add an open brace ({) and then press the Enter key. JDeveloper automatically creates the closing brace, and positions the cursor in a new empty line between the braces.


	
On a new line, declare an OracleDataSource instance as follows:


OracleDataSource ds;


	
Enter the following to create a new OracleDataSource object:


ds = new OracleDataSource();


	
Start to enter the following to set the URL for the DataSource object:


ds.setURL(jdbcUrl);


Java Code Insight prompts you by providing you with a list of available OracleDataSource methods. Scroll through the list to select the setURL(String) method, and press the Enter key to select it into your code. In the parentheses for this function, enter jdbcUrl in place of arg0.

Figure 3-7 shows how the Java Code Insight feature in JDeveloper helps you with inserting code.


Figure 3-7 Java Code Insight

[image: Description of Figure 3-7 follows]





	
On the next line, enter the following:


conn = ds.getConnection(userid,password);


As usual, Java Code Insight will prompt you with a list of methods for ds. This time, select getConnection(String,String). In the parentheses, enter userid,password. End the line with a semicolon (;).

Your code should look similar to the code in Example 3-5.


Example 3-5 Adding a Method to Connect to the Database


package hr;
import java.sql.Connection;
import java.sql.SQLException;
 
import oracle.jdbc.pool.OracleDataSource;
 
public class DataHandler {
    public DataHandler() {
    }
    String jdbcUrl = null;
    String userid = null;
    String password = null; 
    Connection conn;
    public void getDBConnection() throws SQLException{
        OracleDataSource ds;
        ds = new OracleDataSource();
        ds.setURL(jdbcUrl);
        conn=ds.getConnection(userid,password);
        
    }
}




	
Compile your class to ensure that there are no syntax errors. To do this, right-click in the Java Source Editor, and select Make from the shortcut menu. A Successful compilation message is displayed in the Log window below the Java Source Editor window.

















4 Querying for and Displaying Data

This chapter adds functions and code to the DataHandler.java file for querying the database. This chapter has the following sections:

	
Overview of Querying for Data in Oracle Database XE


	
Querying Data from a Java Application


	
Creating JSP Pages


	
Adding Dynamic Content to the JSP Page: Database Query Results


	
Filtering a Query Result Set


	
Adding Login Functionality to the Application


	
Testing the JSP Page






4.1 Overview of Querying for Data in Oracle Database XE

In outline, to query Oracle Database XE from a Java class to retrieve data, you must do the following:

	
Create a connection by using the OracleDataSource.getConnection method. This is covered in Chapter 3, "Connecting to Oracle Database XE".


	
Define your SQL statements with the methods available for the connection object. The createStatement method is used to define a SQL query statement.


	
Using the methods available for the statement, run your queries. You use the executeQuery method to run queries on the database and produce a set of rows that match the query conditions. These results are contained in a ResultSet object.


	
You use a ResultSet object to display the data in the application pages.




The following sections describe important Java Database Connectivity (JDBC) concepts related to querying the database from a Java application:

	
SQL Statements


	
Query Methods for the Statement Object


	
Result Sets






4.1.1 SQL Statements

Once you connect to the database and, in the process, create a Connection object, the next step is to create a Statement object. The createStatement method of the JDBC Connection object returns an object of the JDBC Statement type. Example 4-1 shows how to create a Statement object.


Example 4-1 Creating a Statement Object


Statement stmt = conn.createStatement();




The Statement object is used to run static SQL queries that can be coded into the application.

In addition, for scenarios where many similar queries with differing update values must be run on the database, you use the OraclePreparedStatement object, which extends the Statement object. To access stored procedures on Oracle Database XE, you use the OracleCallableStatement object.




	
See Also:

	
Using OraclePreparedStatement


	
Using OracleCallableStatement

















4.1.2 Query Methods for the Statement Object

To run a query embedded in a Statement object, you use variants of the execute method. Important variants of this method are listed in Table 4-1.


Table 4-1 Key Query Execution Methods for java.sql.Statement

	Method Name	Return Type	Description
	
execute(String sql)

	
Boolean

	
Runs the given SQL statement, which returns a Boolean response: true if the query runs successfully and false if it does not.


	
addBatch()

	
void

	
Adds a set of parameters to a PreparedStatement object batch of commands.


	
executeBatch()

	
int[]

	
Submits a batch of commands to the database for running, and returns an array of update counts if all commands run successfully.


	
executeQuery(String sql)

	
ResultSet

	
Runs the given SQL statement, which returns a single ResultSet object.


	
executeUpdate(String sql)

	
int

	
Runs the given SQL statement, which may be an INSERT, UPDATE, or DELETE statement or a SQL statement that returns nothing, such as a SQL DDL statement.











	
See Also:

http://www.oracle.com/technetwork/java/javase/documentation/api-jsp-136079.html












4.1.3 Result Sets

A ResultSet object contains a table of data representing a database result set, which is generated by executing a statement that queries the database.

A cursor points to the current row of data in a ResultSet object. Initially, it is positioned before the first row. Use the next method of the ResultSet object to move the cursor to the next row in the result set. It returns false when there are no more rows in the ResultSet object. Typically, the contents of a ResultSet object are read by using the next method within a loop until it returns false.

The ResultSet interface provides accessor methods (getBoolean, getLong, getInt, and so on) for retrieving column values from the current row. Values can be retrieved by using either the index number of the column or the name of the column.

By default, only one ResultSet object per Statement object can be open at the same time. Therefore, to read data from multiple ResultSet objects, you must use multiple Statement objects. A ResultSet object is automatically closed when the Statement object that generated it is closed, rerun, or used to retrieve the next result from a sequence of multiple results.




	
See Also:

	
http://download.oracle.com/javase/1.3/docs/guide/jdbc/getstart/mapping.html for more information about mapping SQL types and Java types


	
Oracle Database JDBC Developer's Guide for more information about result sets and their features














4.1.3.1 Features of ResultSet Objects

Scrollability refers to the ability to move backward as well as forward through a result set. You can also move to any particular position in the result set, through either relative positioning or absolute positioning. Relative positioning lets you move a specified number of rows forward or backward from the current row. Absolute positioning lets you move to a specified row number, counting from either the beginning or the end of the result set.

When creating a scrollable or positionable result set, you must also specify sensitivity. This refers to the ability of a result set to detect and reveal changes made to the underlying database from outside the result set. A sensitive result set can see changes made to the database while the result set is open, providing a dynamic view of the underlying data. Changes made to the underlying column values of rows in the result set are visible. Updatability refers to the ability to update data in a result set and then copy the changes to the database. This includes inserting new rows into the result set or deleting existing rows. A result set may be updatable or read-only.






4.1.3.2 Summary of Result Set Object Types

Scrollability and sensitivity are independent of updatability, and the three result set types and two concurrency types combine for the following six result set categories:

	
Forward-only/read-only


	
Forward-only/updatable


	
Scroll-sensitive/read-only


	
Scroll-sensitive/updatable


	
Scroll-insensitive/read-only


	
Scroll-insensitive/updatable




Example 4-2 demonstrates how to declare a scroll-sensitive and read-only ResultSet object.


Example 4-2 Declaring a Scroll-Sensitive, Read-Only ResultSet Object


stmt = conn.createStatement(ResultSet.TYPE_SCROLL_SENSITIVE, ResultSet.CONCUR_READ_ONLY);






	
Note:

A forward-only updatable result set has no provision for positioning at a particular row within the ResultSet object. You can update rows only as you iterate through them using the next method.














4.2 Querying Data from a Java Application

This section discusses how you can use JDeveloper to create a Java class that queries data in Oracle Database XE in the following sections:

	
Creating a Method in JDeveloper to Query Data


	
Testing the Connection and the Query Methods






4.2.1 Creating a Method in JDeveloper to Query Data

The following steps show you how to add a simple query method to your DataHandler.java class. If DataHandler.java is not open in the JDeveloper integrated development environment (IDE), double-click the DataHandler.java file in the Application Navigator to display it in the Java Source Editor.

	
In the DataHandler class, add the following import statements after the existing import statements to use the Statement and ResultSet JDBC classes:


import java.sql.Statement;
import java.sql.ResultSet;


	
After the connection declaration, declare variables for Statement, ResultSet, and String objects as follows:


Statement stmt;
ResultSet rset;
String query;
String sqlString;


	
Create a method called getAllEmployees, which will be used to retrieve employee information from the database. Enter the signature for the method:


public ResultSet getAllEmployees() throws SQLException{ 


	
Press the Enter key to include the closing brace for the method and a new line to start entering the method code.


	
Call the getDBConnection method created earlier:


getDBConnection();


	
After calling the getDBConnection method, use the createStatement method of the Connection instance to provide context for executing the SQL statement and define the ResultSet type. Specify a read-only, scroll-sensitive ResultSet type as stated in the following code:


stmt = conn.createStatement(ResultSet.TYPE_SCROLL_SENSITIVE, ResultSet.CONCUR_READ_ONLY);


The Java Code Insight feature can help you ensure that the statement syntax is correct.


	
Define the query and print a trace message. The following code uses a simple query to return all the rows and columns in the Employees table, where the data is ordered by the Employee ID:


query = "SELECT * FROM Employees ORDER BY employee_id";
System.out.println("\nExecuting query: " + query);


	
Run the query and retrieve the results in the ResultSet instance as follows:


rset = stmt.executeQuery(query); 


	
Return the ResultSet object:


return rset;


	
Save your work. From the File menu, select Save All.




The code for the getAllEmployees method should be as shown in Example 4-3.


Example 4-3 Using the Connection, Statement, Query, and ResultSet Objects


    public ResultSet getAllEmployees() throws SQLException{
        getDBConnection(); 
        stmt = conn.createStatement(ResultSet.TYPE_SCROLL_SENSITIVE,
               ResultSet.CONCUR_READ_ONLY);
        query = "SELECT * FROM Employees ORDER BY employee_id";
        System.out.println("\nExecuting query: " + query);
        rset = stmt.executeQuery(query); 
        return rset;
    }








4.2.2 Testing the Connection and the Query Methods

In the following steps, you create a simple Java class to test the methods in the DataHandler.java class. To test your application at this stage, you can temporarily set the value of the jdbcUrl variable to the connection string for your database and set the values of the userid and password variables to the values required to access the HR schema.

	
Open the DataHandler.java class in the Java Visual Editor from the Application Navigator.


	
Change the jdbcUrl, userid and password variables to contain the values required for the HR schema as follows:


String jdbcUrl = "connect-string";
String userid = "HR";
String password = "hr";


where connect-string is, for example:


jdbc:oracle:thin:@localhost:1521:XE




	
See Also:

Declaring Connection-Related Variables in Chapter 3






	
Create a new Java class named JavaClient in the hr package. Make it a public class and generate a default constructor and a main method. Note that you must select the Main Method check box from the Optional Attributes panel to generate the main method.

The skeleton JavaClient.java class is created and displayed in the Java Source Editor.



	
See Also:

Creating a Java Class in JDeveloper in Chapter 3 for information about creating a Java class file






	
Import the ResultSet package:


import java.sql.ResultSet;


	
In the main method declaration, add exception handling as follows:


public static void main(String[] args) throws Exception{


	
Replace the JavaClient object created by default with a DataHandler object. Locate the following line in the main method:


JavaClient javaClient = new JavaClient();


Replace this with:


DataHandler datahandler = new DataHandler();


	
Define a ResultSet object to hold the results of the getAllEmployees query, and iterate through the rows of the result set, displaying the first four columns, Employee Id, First Name, Last Name, and Email. To do this, add the following code to the main method:


ResultSet rset = datahandler.getAllEmployees();

while (rset.next()) {
System.out.println(rset.getInt(1) + " " +
  rset.getString(2) + " " + 
  rset.getString(3) + " " + 
  rset.getString(4));
}


	
Compile the JavaClient.java file to check for compilation errors. To do this, right-click in the Java Source Editor, and select Make from the shortcut menu.

If there are no errors in compilation, you should see the following message in the Log window:

Successful compilation: 0 errors, 0 warnings


	
Run the JavaClient.java file. To do this, right-click in the Java Source Editor window and select Run from the shortcut menu.


	
Examine the output in the Log window. Notice the trace message, followed by the four columns from the Employees table as shown in Figure 4-1.


Figure 4-1 Test Output for Query Method in Log Window

[image: Description of Figure 4-1 follows]





	
When you finish testing the application, set the jdbcUrl, userid and password variables in DataHandler.java back to null.







	
See Also:

Declaring Connection-Related Variables














4.3 Creating JSP Pages

The HRApp application uses JavaServer Pages (JSP) technology to display data. JSP technology provides a simple, fast way to create server-independent and platform-independent dynamic Web content. A JSP page has the .jsp extension. This extension notifies the Web server that the page should be processed by a JSP container. The JSP container interprets the JSP tags and scriptlets, generates the content required, and sends the results back to the client as an HTML or XML page.

To develop JSP pages, you use some or all of the following:

	
HTML tags to design and format the dynamically generated Web page


	
Standard JSP tags or Java-based scriptlets to call other components that generate the dynamic content on the page


	
JSP tags from custom tag libraries that generate the dynamic content on the page







	
See Also:

http://www.oracle.com/technetwork/java/javaee/jsp/index.html









In this section, you will see how you can create JSP pages for the application in this guide in the following sections:

	
Overview of Page Presentation


	
Creating a Simple JSP Page


	
Adding Static Content to a JSP Page


	
Adding a Style Sheet to a JSP Page






4.3.1 Overview of Page Presentation

In the application created in this guide, JSP pages are used to do the following tasks:

	
Display data


	
Hold input data entered by users adding employees and editing employee data


	
Hold the code needed to process the actions of validating user credentials and adding, updating, and deleting employee records in the database




JSP pages are presented to users as HTML or XML. So, you can control the presentation of data in the same way as you do it for static HTML and XML pages. You can use standard HTML tags to format your page, including the title tag in the header to specify the title to be displayed for the page.

You use HTML tags for headings, tables, lists, and other items on your pages. Style sheets can also be used to define the presentation of items. If you use JDeveloper to develop your application, you can select styles from a list.

The following sections describe the main elements used in the JSP pages of the sample application:

	
JSP Tags


	
Scriptlets


	
HTML Tags


	
HTML Forms






4.3.1.1 JSP Tags

JSP tags are used in the sample application in this guide for the following tasks: to initialize Java classes that hold the application methods and the JavaBean used to hold a single employee record, and to forward the user to either the same or another page in the application.

The jsp:useBean tag is used in pages to initialize the class that contains all the methods needed by the application, and the jsp:forward tag is used to forward the user to a specified page. You can drag the tags you need from the Component Palette of JSP tags, and enter the properties for the tag in the corresponding dialog box that is displayed.






4.3.1.2 Scriptlets

Scriptlets are used to run the Java methods that operate on the database and to perform other processing in JSP pages. You can drag a scriptlet tag component from the Component Palette and drop it onto your page, ready to enter the scriptlet code. In JDeveloper, the code for scriptlets is entered in the Scriptlet Source Editor dialog box.

In this application, you use scriplets for a variety of tasks. As an example, one scriptlet calls the DataHandler method that returns a ResultSet object containing all the employees in the Employees table, which you can use to display that data in your JSP page. As another example, a scriplet is used to iterate through the same ResultSet object to display each item in a row of a table.






4.3.1.3 HTML Tags

HTML tags are typically used for layout and presentation of the nondynamic portions of the user interface, for example headings and tables. In JDeveloper, you can drag and drop a Table component from the Component Palette onto your page. You must specify the number of rows and columns for the table, and all the table tags are automatically created.






4.3.1.4 HTML Forms

HTML forms are used to interact with or gather information from the users on Web pages. The FORM element acts as a container for the controls on a page, and specifies the method to be used to process the form input.

For the filter control to select which employees to display, the employees.jsp page itself processes the form. For login, insert, edit, and delete operations, additional JSP pages are created to process these forms. To understand how the JSP pages in this application are interrelated, refer to Figure 1-2.

You can add a form in a JSP page by selecting it from the Component Palette of HTML tags. If you attempt to add a control on a page outside of the form component or in a page that does not contain a form, then JDeveloper prompts you to add a form component to contain it.








4.3.2 Creating a Simple JSP Page

The following steps describe how to create a simple JSP page:

	
In the Application Navigator, right-click the View project and choose New from the shortcut menu.


	
In the New Gallery, select the All Technologies tab.


	
Expand the Web Tier node from the Categories list and select JSP.


	
In the Items list, select JSP and click OK.


Figure 4-2 Creating a JSP Page

[image: Description of Figure 4-2 follows]





The Create JSP dialog box is displayed.


	
On the Create JSP dialog box, enter employees.jsp in the File Name text box and click OK. The new page opens in the JSP/HTML Visual Editor and is ready for you to start adding text and components to your web page.









4.3.3 Adding Static Content to a JSP Page

JDeveloper provides the Component Palette and the Property Inspector on the right hand side of the JSP/HTML Visual Editor. You can also use the JSP Source Editor by clicking the Source Editor tab next to the Design tab at the bottom of the page. The Component Palette enables you to add components to the page and the Property Inspector enables you to set the properties of the components. A blank page in the Visual Editor is shown in Figure 4-3.


Figure 4-3 Adding Content to JSP Pages in the JDeveloper Visual Source Editor

[image: Description of Figure 4-3 follows]





The following steps show how you can add text to the employees.jsp page. They use the Visual Editor to modify the JSP. The Visual Editor is like a WYSIWYG editor and you can use it to modify content.

	
With employees.jsp open in the Visual Editor, in the top line of your page, type AnyCo Corporation: HR Application. From the list of styles at the top of the page, on the left-hand side, select Heading 2.


Figure 4-4 Formatting a JSP

[image: Setting JSP style]



	
With the cursor still on the heading you added, from the Design menu select Align, and then Center.


	
In a similar way, on a new line, type Employee Data, and format it with the Heading 3 style. Position it on the left-hand side of the page.









4.3.4 Adding a Style Sheet to a JSP Page

You can add a style sheet reference to your page, so that your headings, text, and other elements are formatted in a consistent way with the presentation features, such as the fonts and colors used in the Web pages. You can add a style sheet to the page as follows:

	
With employees.jsp open in the Visual Editor, click the list arrow at the top right of the Component Palette, and select CSS.


Figure 4-5 Selecting a CSS File for the JSP

[image: Applying a CSS to a JSP]



	
From the CSS list, drag JDeveloper onto your page. As soon as you drag JDeveloper onto your page, it will ask you to save the jdeveloper.css file. Save the file in the same location as your JSP file. After you save the CSS file, it formats the page with the JDeveloper styles. Figure 4-6 shows the JSP Page with the content added to it in the previous section and the JDeveloper stylesheet applied to it.


Figure 4-6 Adding Static Content to the JSP Page

[image: Description of Figure 4-6 follows]








	
Note:

In JDeveloper version 10.1.3, you can associate a stylesheet with the JSP page while creating it in the JSP Creation Wizard. The only difference is that you need to browse and locate the stylesheet to be applied to the JSP page, instead of just dragging and dropping it onto the page.

















4.4 Adding Dynamic Content to the JSP Page: Database Query Results

This section includes the following subsections:

	
Adding a JSP useBean Tag to Initialize the DataHandler Class


	
Creating a Result Set


	
Adding a Table to the JSP Page to Display the Result Set






4.4.1 Adding a JSP useBean Tag to Initialize the DataHandler Class

A jsp:useBean tag identifies and initializes the class that holds the methods that run in the page. To add a jsp:useBean tag, follow these steps:

	
Open employees.jsp in the Visual Editor.


	
In the Component Palette, select the JSP set of components. Scroll through the list and drag and drop UseBean to your page. The Insert UseBean dialog box is displayed.


	
In the Insert UseBean dialog box, enter empsbean as the ID. For the Class, click Browse.... The Class Browser dialog box is displayed. Type hr.DataHandler in the Match Class Name text box. Click OK. Leave the Type and BeanName fields blank and set the Scope to session.


	
Click OK to create the tag in the page.




Figure 4-7 shows the representation of the useBean tag in the employees.jsp page.


Figure 4-7 useBean Representation in the employees.jsp File

[image: Description of Figure 4-7 follows]





If you do not see the UseBean tag on the design view of the JSP, then go to Preferences from the Tools menu, and select the Show Invisible JSP Elements option, which is shown Figure 4-8.


Figure 4-8 Preferences Window to Select JSP and HTML Visual Editor Options

[image: Description of Figure 4-8 follows]









4.4.2 Creating a Result Set

The following steps describe how you can add a scripting element to your page to call the getAllEmployees method and hold the result set data that is returned. This query is defined in the DataHandler class, and initialized in the page by using the jsp:useBean tag.

	
Open the employees.jsp page in the Visual Editor. In the JSP part of the Component Palette, select Scriptlet and drag and drop it onto the JSP page next to the representation of the UseBean.


	
In the Insert Scriptlet dialog box, enter the following lines of code, which will call the getAllEmployees method and produce a ResultSet object:


ResultSet rset;
rset = empsbean.getAllEmployees();


Click OK. A representation of the scriptlet is displayed on the page as shown in Figure 4-9.


Figure 4-9 Scriptlet Representation in a JSP Page

[image: Description of Figure 4-9 follows]





	
Select the Source tab at the bottom of the Visual Editor to see the code that has been created for the page so far. A wavy line under ResultSet indicates that there are errors in the code.


	
The Structure window on the left-hand side also indicates any errors in the page. Scroll to the top of the window and expand the JSP Errors node. Figure 4-10 shows how the error in the code is shown in the Structure window.


Figure 4-10 Viewing Errors in the Structure Window

[image: JSP errors shown in the structure window]



	
You must import the ResultSet package. To do this, click the page node in the Structure window to display the page properties in the Property Inspector on the left side of the main editing area.


	
Right-click inside the empty box to the right of the import property and click Edit. The Edit Property: Import dialog box is displayed, which is shown in Figure 4-11.


Figure 4-11 Importing Packages in JDeveloper

[image: Description of Figure 4-11 follows]





	
Select the Hierarchy tab, expand the java node, then the sql node, and then select ResultSet. Click OK.


	
On the Source tab, examine the code to see if the import statement has been added to the code for your page. The error should disappear from the list in the Structure window. Before continuing with the following sections, return to the design view of the page by selecting the Design tab.









4.4.3 Adding a Table to the JSP Page to Display the Result Set

The following steps describe how you can add a table to the JSP page to display the results of the getAllEmployees query:

	
If the employees.jsp page is not open in the Visual Editor, double-click it in the Application Navigator to open it, and work in the Design tab. With the employees.jsp file open in the Visual Editor, position the cursor after the scriptlet and from the HTML Common page of the Component Palette, select the Table component, which is shown in Figure 4-12.


Figure 4-12 Common HTML Components in the Component Palette

[image: Component palette for HTML]



	
In the Insert Table dialog box, specify 1 row and 6 columns. Leave all Layout properties as default. Click OK.


	
In the table row displayed on the page, enter text as follows for the headings for each of the columns: First Name, Last Name, Email, Job, Phone, Salary. Use Heading 4 to format the column names.


	
Add a scripting element for output, this time to display the values returned for each of the columns in the table. To do this, select the table as follows. Position the cursor on the top border of the table, and click when the cursor image changes to a table image. From the JSP Component Palette, select Scriptlet. (You need not drag the scriptlet into your table; it is inserted automatically.)


	
In the Insert Scriptlet dialog box, enter the following lines of code:


    while (rset.next ())
    {
    out.println("<tr>");
    out.println("<td>" + 
      rset.getString("first_name") + "</td><td> " + 
      rset.getString("last_name") + "</td><td> " + 
      rset.getString("email") + "</td><td> " + 
      rset.getString("job_id") + "</td><td>" + 
      rset.getString("phone_number") + "</td><td>" + 
      rset.getDouble("salary") + "</td>");
    out.println("</tr>");
    }


	
Click OK.




The JSP page created is shown in Figure 4-13.


Figure 4-13 Table in a JSP Page

[image: Description of Figure 4-13 follows]











4.5 Filtering a Query Result Set

You can filter the results of a query by certain parameters or conditions. You can also allow users of the application to customize the data filter. In the sample application created in this guide, the procedure of filtering the query result consists of the following tasks:

	
Determining what filtered set is required

Users can specify the set of employee records that they want to view by entering a filter criterion in a query field, in this case, a part of the name that they want to search for. The employees.jsp page accepts this input through form controls, and processes it.


	
Creating a method to return a query ResultSet

The user input string is used to create the SQL query statement. This statement selects all employees whose names include the sequence of characters that the user enters. The query searches for this string in both the first and the last names.


	
Displaying the results of the query

This is done by adding code to the employees.jsp page to use the method that runs the filtered query.




This section describes filtering query data in the following sections:

	
Creating a Java Method for Filtering Results


	
Testing the Query Filter Method


	
Adding Filter Controls to the JSP Page


	
Displaying Filtered Data in the JSP Page






4.5.1 Creating a Java Method for Filtering Results

The following steps describe how you can create the getEmployeesByName method. This method enables users to filter employees by their first or last name.

	
From the Application Navigator, open the DataHandler.java class in the Java Visual Editor.


	
After the getAllEmployees method, declare the getEmployeesByName method as follows:


public ResultSet getEmployeesByName(String name) throws SQLException {

}


	
Within the body of the method, add the following code to convert the name to uppercase to enable more search hits:


name = name.toUpperCase();


	
Call the method to connect to the database:


getDBConnection();


	
Specify the ResultSet type and create the query:


stmt = conn.createStatement(ResultSet.TYPE_SCROLL_SENSITIVE, 
                            ResultSet.CONCUR_READ_ONLY);
query =
"SELECT * FROM Employees WHERE UPPER(first_name) LIKE \'%" + name + "%\'" +
" OR UPPER(last_name) LIKE \'%" + name + "%\' ORDER BY employee_id";


	
Print a trace message:


System.out.println("\nExecuting query: " + query);


	
Run the query and return a result set as before:


rset = stmt.executeQuery(query);
return rset; 


	
Save the file and compile it to ensure there are no compilation errors.









4.5.2 Testing the Query Filter Method

You can use the JavaClient.java class created in Testing the Connection and the Query Methods to test the getEmployeesByName method. You must add the getEmployeesByName method to display the query results as described in the following steps:

	
Open the JavaClient.java class in the Java Source Editor.


	
After the result set displaying the results from the getAllEmployees query, define a result set for the conditional query as follows:


rset = datahandler.getEmployeesByName("King");
 
System.out.println("\nResults from query: ");
 
while (rset.next()) {
  System.out.println(rset.getInt(1) + " " + 
  rset.getString(2) + " " + 
  rset.getString(3) + " " + 
  rset.getString(4));
}


	
To test your application at this stage, you can temporarily adjust the values of the jdbcUrl, userid and password variables in the DataHandler class to provide the values required for the HR schema. Save the file, and compile it to check for syntax errors.




	
Note:

Make sure you change the values of userid, password, and jdbcUrl back to null after testing. For more information, refer to Declaring Connection-Related Variables.








	
To test-run the code, right-click in the Java Source Editor and select Run from the shortcut menu. In the Log window, you will first see the results of the getAllEmployees method, then the results from the getEmployeesByName("xxx") query. Here, xxx is set to "King" to test the filtering functionality. In actual operation, this parameter will be set to the value provided by the user of the application to filter the search.









4.5.3 Adding Filter Controls to the JSP Page

To accept the filter criterion and to display the filter results, you must modify the employees.jsp page. In the following steps, you add a form element and controls to the employees.jsp page that accepts input from users to filter employees by name:

	
With the employees.jsp page displayed in the Visual Editor, position the cursor between the useBean tag and the scriptlet.


	
In the HTML Forms page of the Component Palette, select Form.


	
In the Insert Form dialog box, use the down arrow for the Action field and select employees.jsp. Leave the other fields empty and click OK.

The form is displayed on the page in the Visual Editor, represented by a dotted-line rectangle.


	
In the HTML Forms page of the Component Palette, scroll to Text Field. Select it and drag and drop it inside the Form component. In the Insert Text Field dialog, enter query as the value of the Name field and click OK. The text field box is displayed within the form. This field enables users to enter filter criteria.


	
Position the cursor to the left of the Text Field and add the following text:

Filter by Employee Name:


	
In the HTML Forms page of the Component Palette, scroll to Submit Button. Select it and drop it inside the Form component to the right of the Text Field.


	
In the Insert Submit Button dialog box, leave the Name field empty and enter Filter as the value of the Value field, and click OK.

Figure 4-14 shows these HTML Form components in the employees.jsp file.


Figure 4-14 HTML Form Components in the JSP Page

[image: Description of Figure 4-14 follows]












4.5.4 Displaying Filtered Data in the JSP Page

In the previous section, you created a text field component on the JSP page that accepts user input. In this text field, users can specify a string with which to filter employee names. You also added a submit button.

In the following steps, you add code to the scriptlet in the employees.java file to enable it to use the getEmployeesByName method. This method is used only if a user submits a value for filtering the results. If this filter criterion is not specified, the getAllEmployees method is used.

	
Open the employees.jsp file in the Visual Editor.


	
Double-click the Scriptlet tag on the page (not the one inside the table) to open the Properties dialog box. Modify the code as follows:


ResultSet rset;
String query = request.getParameter("query");
if (query != null && query != null)
  rset = empsbean.getEmployeesByName(query);
else
  rset = empsbean.getAllEmployees();


Figure 4-15 shows how you can use the Scriptlet Properties dialog box to modify the code.


Figure 4-15 Using the Scriptlet Properties Dialog Box

[image: Description of Figure 4-15 follows]





	
Click OK.


	
Save the file.











4.6 Adding Login Functionality to the Application

The login functionality used in the sample application is a simple example of application-managed security. It is not a full Java EE security implementation, but simply used as an example in the sample application.

To implement this simple login functionality, you must perform the following tasks:

	
Creating a Method to Authenticate Users


	
Creating a Login Page


	
Preparing Error Reports for Failed Logins


	
Creating the Login Interface


	
Creating a JSP Page to Handle Login Action






4.6.1 Creating a Method to Authenticate Users

In the following steps, you create a method in the DataHandler.java class that authenticates users by checking that the values they supply for the userid and password match those required by the database schema.

	
Open the DataHandler.java class in the Source Editor.


	
Create a method called authenticateUser that checks if the userid, password, and host values supplied by a user are valid:


public boolean authenticateUser(String jdbcUrl, String userid, String password,
  HttpSession session) throws SQLException {
 
}


	
JDeveloper prompts you with a wavy underline and a message that you must import a class for HttpSession. Press the Alt+Enter keys to import the javax.servlet.http.HttpSession class.


	
Within the body of the method, assign the jdbcUrl, userid, and password values from the call to the attributes of the current object as follows:


this.jdbcUrl= jdbcUrl;
this.userid = userid;
this.password = password;


	
Attempt to connect to the database using the values supplied, and if successful, return a value of true. Enclose this in a try block as follows:


try {
  OracleDataSource ds;
  ds = new OracleDataSource();
  ds.setURL(jdbcUrl);
  conn = ds.getConnection(userid, password);
  return true;
}




	
See Also:

For information about using try and catch blocks, refer to Exception Handling in Chapter 5.






	
To handle the case where the login credentials do not match, after the try block, add a catch block. The code in this block prints out a log message and sets up an error message. This error message can be displayed to the user if a login attempt fails. The jdbcUrl, userid and password variables are set back to null, and the method returns the value false. To do this, enter the following code:


catch ( SQLException ex )  {
  System.out.println("Invalid user credentials");
  session.setAttribute("loginerrormsg", "Invalid Login. Try Again...");
  this.jdbcUrl = null;
  this.userid = null;
  this.password = null;
  return false;
} 




The complete code is shown in Example 4-4.


Example 4-4 Implementing User Validation


public boolean authenticateUser(String jdbcUrl, String userid, String password,
  HttpSession session) throws SQLException {
 
  this.jdbcUrl = jdbcUrl;
  this.userid = userid;
  this.password = password;
  try {
    OracleDataSource ds;
    ds = new OracleDataSource();
    ds.setURL(jdbcUrl);
    conn = ds.getConnection(userid, password);
    return true;
  } catch ( SQLException ex )  {
  System.out.println("Invalid user credentials");
  session.setAttribute("loginerrormsg", "Invalid Login. Try Again...");
  this.jdbcUrl = null;
  this.userid = null;
  this.password = null;
  return false;
  } 
}








4.6.2 Creating a Login Page

The following steps create a login.jsp page, on which users enter the login details for the schema they are going to work on:

	
In the View project, create a new JSP page. Change the Name to login.jsp and accept all other defaults. The new page opens in the JSP/HTML Visual Editor and is ready for you to start adding text and components to your Web page.


	
Drag and drop the already saved JDeveloper style sheet to the page from the Project CSS Files panel, which is shown in Figure 4-16.


Figure 4-16 Project CSS Files Panel

[image: Project CSS Files Panel]



	
Give the page the same heading as earlier, AnyCo Corporation: HR Application, apply the Heading 2 style to it, and align it to the center of the page.


	
On the next line, enter Application Login, with the Heading 3 style applied. Align this heading to the left-hand side of the page.









4.6.3 Preparing Error Reports for Failed Logins

The following steps add functions to the login.jsp page for displaying error messages when a user login fails. The scriptlets and expression used in the login.jsp page set up a variable to hold any error message. If the user login fails, the connection method sets a message for the session. This page checks to see if there is such a message, and if present, it displays the message.

	
With the login.jsp page open in the Visual Editor, position the cursor after the text on this page. Then, from the JSP page of the Component Palette, drag and drop the Scriptlet element from the palette onto the page.


	
In the Insert Scriptlet dialog box, enter the following code:


    String loginerrormsg = null;
    loginerrormsg = (String) session.getAttribute("loginerrormsg");
    if (loginerrormsg != null) {


	
Add another scriptlet in exactly the same way, and this time enter only a single closing brace (}) in the Insert Scriptlet dialog box.


	
Place the cursor between the two scriptlets and press Enter to create a new line. Apply the Heading 4 style to the new line.


	
With the cursor still on the new line, in the JSP page of the Component Palette, click Expression.


	
In the Insert Expression dialog box, enter loginerrormsg.


	
To see the code that has been added to your login.jsp page, below the Visual Editor, select the Source tab. The code should appear as follows:


<% 
    String loginerrormsg = null;
    loginerrormsg = (String) session.getAttribute("loginerrormsg");
    if (loginerrormsg != null) {
%>
<h4>
  <%=  loginerrormsg %>
</h4>
<% 
}
%>




Before continuing with the following sections, return to the design view of the page by selecting the Design tab.






4.6.4 Creating the Login Interface

In these steps, you add fields to the login.jsp page on which users enter their login details.

	
If the login.jsp page is not open in the Visual Editor, double-click it in the Application Navigator to open it, and check that the Design tab is selected.


	
Position the cursor after the second scriptlet and select Form in the HTML Forms page of the Component Palette. In the Insert Form dialog box, enter login_action.jsp as the value for the Action field. This file will be used to process the user input in the login.jsp file. (You cannot select this page from a list as it is not created yet.) Leave the other fields empty and click OK.

The Form is displayed on the page in the Visual Editor, represented by a dotted rectangle.


	
Add a Table to the page. Position it inside the Form. Specify a 3-row and 2-column layout, and accept other layout defaults.


	
In the first column of the three rows, enter the following as the text to display for users:

User ID:

Password:

Host:


	
From the HTML page of the Component Palette, drag a Text Field into the table cell to the right of the User ID: cell. In the Insert Text Field dialog box, enter userid as the value of the Name property. Leave the other fields empty and click OK.


	
In the same way, add a Text Field to the table cell to the right of the Password: cell and enter password as the value of the Name property. Similarly, add a Text Field to the table cell to the right of the Host: cell and enter host as the value of the Name property.


	
Drag a Submit button to the Form below the table. Enter Submit for the Value property of the button.




Your login.jsp page should now appear as shown in Figure 4-17.


Figure 4-17 Login Page

[image: Description of Figure 4-17 follows]









4.6.5 Creating a JSP Page to Handle Login Action

In the following steps, you create the login_action.jsp page, which is a nonviewable page that processes the login operation.

	
Create a JSP page and call it login_action.jsp. Accept all default settings for the JSP page.


	
With login_action.jsp open in the Visual Editor, click and select the Page Directive on the top left corner of the page. The Property Inspector now shows the properties of the Page Directive.


	
Click the down arrow next to the Import field. The Edit Property: Import dialog box is displayed. Select the Hierarchy tab and then select ResultSet after extending Java and SQL folders respectively. Click OK.


	
Drag a jsp:usebean tag onto the page. Enter empsbean as the ID and browse to select hr.DataHandler as the Class. Set the Scope to session, and click OK.


	
Position the cursor after the useBean tag and add a Scriptlet to the page. Enter the following code into the Insert Scriptlet dialog box and click OK.


boolean userIsValid = false;
String host = request.getParameter("host");
String userid = request.getParameter("userid");
String password = request.getParameter("password");
String jdbcUrl = "jdbc:oracle:thin:@" + host + ":1521:XE";
userIsValid = empsbean.authenticateUser(jdbcUrl, userid, password, session);


	
Add another Scriptlet, and add the following code to it:


if (userIsValid){


	
In the JSP page of the Component Palette, find Forward and drag it onto the page to add a jsp:forward tag onto the page. In the Insert Forward dialog box, enter employees.jsp as the value of the Page* field.


	
Add another scriptlet, and enter the following code:


} else {


	
Add another jsp:forward tag, and this time move forward to login.jsp.


	
Add a final Scriptlet, and enter a closing brace (}).


	
Save your work.




To see the code that has been added to login_action.jsp, select the Source tab. The code displayed is similar to the following:


<body>
<%@ page import="java.sql.ResultSet"%><jsp:useBean id="empsbean"
                                                   class="hr.DataHandler"
                                                   scope="session"/>
<%boolean userIsValid = false;
String host = request.getParameter("host");
String userid = request.getParameter("userid");
String password = request.getParameter("password");
String jdbcUrl = "jdbc:oracle:thin:@" + host + ":1521:XE";
userIsValid = empsbean.authenticateUser(jdbcUrl, userid, password, session);%> <%if(userIsValid){%><jsp:forward page="employees.jsp"/>
<%if (userIsValid){%><jsp:forward page="login.jsp"/><%}%>
</body>








4.7 Testing the JSP Page

To test the login page and the filtering of employees, do the following:

	
In the Application Navigator, right-click the view project, and select Run.

You may be prompted to specify a Default Run Target for the project. For now, set this to login.jsp. You can later change the project properties for the default run target page to be any page of your choice.

The login page is displayed in your browser, as shown in Figure 4-18.


Figure 4-18 Login Page for Sample Application in the Browser

[image: Description of Figure 4-18 follows]





	
Enter the following login details for your database, and then click Submit.

User ID: HR

Password: hr

Host: localhost

The Employee.java file is displayed in your browser as shown in Figure 4-19.


Figure 4-19 Unfiltered Employee Data in employee.jsp

[image: Description of Figure 4-19 follows]





	
Enter a string of letters by which you want to filter employee data. For example, enter ing in the Filter by Employee Name field, and click Filter. A filtered list is displayed, which is shown in:


Figure 4-20 Filtered Employee Data in employee.jsp

[image: Description of Figure 4-20 follows]


















6 Enhancing the Application: Advanced JDBC Features

This chapter describes additional functionality that you can use in your Java application. Some of these features have not been implemented in the sample application, while some features are enhancements you can use in your code to improve performance.

This chapter includes the following sections:

	
Using Dynamic SQL


	
Calling Stored Procedures


	
Using Cursor Variables






6.1 Using Dynamic SQL

Dynamic SQL, or generating SQL statements during run time, is a constant need in a production environment. Very often, and especially in the matter of updates to be performed on a database, the final query is not known until run time.

For scenarios where many similar queries with differing update values must be run on the database, you can use the OraclePreparedStatement object, which extends the Statement object. This is done by substituting the literal update values with bind variables. You can also use stored PL/SQL functions on the database by calling stored procedures through the OracleCallableStatement object.

This section discusses the following topics:

	
Using OraclePreparedStatement


	
Using OracleCallableStatement


	
Using Bind Variables






6.1.1 Using OraclePreparedStatement

To run static SQL queries on the database, you use the Statement object. However, to run multiple similar queries or perform multiple updates that affect many columns in the database, it is not feasible to hard-code each query in your application.

You can use OraclePreparedStatement when you run the same SQL statement multiple times. Consider a query like the following:


SELECT * FROM Employees WHERE ID=xyz;


Every time the value of xyz in this query changes, the SQL statement needs to be compiled again.

If you use OraclePreparedStatement functionality, the SQL statement you want to run is precompiled and stored in a PreparedStatement object, and you can run it as many times as required without compiling it every time it is run. If the data in the statement changes, you can use bind variables as placeholders for the data and then provide literal values at run time.

Consider the following example of using OraclePreparedStatement:


Example 6-1 Creating a PreparedStatement


OraclePreparedStatement pstmt = conn.prepareStatement("UPDATE Employees 
                                SET salary = ? WHERE ID = ?");
   pstmt.setBigDecimal(1, 153833.00)
   pstmt.setInt(2, 110592)   




The advantages of using the OraclePreparedStatement interface include:

	
You can batch updates by using the same PreparedStatement object


	
You can improve performance because the SQL statement that is run many times is compiled only the first time it is run.


	
You can use bind variables to make the code simpler and reusable.









6.1.2 Using OracleCallableStatement

You can access stored procedures on databases using the OracleCallableStatement interface. This interface extends the OraclePreparedStatement interface. The OracleCallableStatement interface consists of standard JDBC escape syntax to call stored procedures. You may use this with or without a result parameter. However, if you do use a result parameter, it must be registered as an OUT parameter. Other parameters that you use with this interface can be either IN, OUT, or both.

These parameters are set by using accessor methods inherited from the OraclePreparedStatement interface. IN parameters are set by using the setXXX methods and OUT parameters are retrieved by using the getXXX methods, XXX being the Java data type of the parameter.

A CallableStatement can also return multiple ResultSet objects.

As an example, you can create an OracleCallableStatement to call the stored procedure called foo, as follows:


Example 6-2 Creating a CallableStatement


OracleCallableStatement cs = (OracleCallableStatement)
conn.prepareCall("{call foo(?)}");




You can pass the string bar to this procedure in one of the following two ways:


cs.setString(1,"bar"); // JDBC standard
// or...
cs.setStringAtName(X, "value"); // Oracle extension






6.1.3 Using Bind Variables

Bind variables are variable substitutes for literals in a SQL statement. They are used in conjunction with OraclePreparedStatement and OracleCallableStatement to specify parameter values that are used to build the SQL statement. Using bind variables has remarkable performance advantages in a production environment.

For PL/SQL blocks or stored procedure calls, you can use the following qualifiers to differentiate between input and output variables: IN, OUT, and IN OUT. Input variable values are set by using setXXX methods and OUT variable values can be retrieved by using getXXX methods, where XXX is the Java data type of the values. This depends on the SQL data types of the columns that you are accessing in the database.








6.2 Calling Stored Procedures

Oracle Java Database Connectivity (JDBC) drivers support the processing of PL/SQL stored procedures and anonymous blocks. They support Oracle PL/SQL block syntax and most of JDBC escape syntax. The following PL/SQL calls would work with any Oracle JDBC driver:


Example 6-3 Calling Stored Procedures


// JDBC syntaxCallableStatement cs1 = conn.prepareCall
                        ( "{call proc (?,?)}" ) ; // stored proc
CallableStatement cs2 = conn.prepareCall
                        ( "{? = call func (?,?)}" ) ; // stored func

// Oracle PL/SQL block syntax
CallableStatement cs3 = conn.prepareCall
                        ( "begin proc (?,?); end;" ) ; // stored proc
CallableStatement cs4 = conn.prepareCall
                        ( "begin ? := func(?,?); end;" ) ; // stored func




As an example of using the Oracle syntax, here is a PL/SQL code snippet that creates a stored function. The PL/SQL function gets a character sequence and concatenates a suffix to it:


Example 6-4 Creating a Stored Function


create or replace function foo (val1 char)
return char as
begin
return val1 || 'suffix';
end;




You can call this stored function in a Java program as follows:


Example 6-5 Calling a Stored Function in Java


OracleDataSource ods = new OracleDataSource();
ods.setURL("jdbc:oracle:thin:@<hoststring>");
ods.setUser("hr");
ods.setPassword("hr");
Connection conn = ods.getConnection();
CallableStatement cs = conn.prepareCall ("begin ? := foo(?); end;");
cs.registerOutParameter(1,Types.CHAR);
cs.setString(2, "aa");
cs.executeUpdate();
String result = cs.getString(1);




The following sections describe how you can use stored procedures in the sample application in this guide:

	
Creating a PL/SQL Stored Procedure in JDeveloper


	
Creating a Method to Use the Stored Procedure


	
Enabling Users to Choose the Stored Procedure


	
Calling the Stored Procedure from the Application






6.2.1 Creating a PL/SQL Stored Procedure in JDeveloper

JDeveloper enables you to create stored procedures in the database through the Database Navigator. In these steps, you create a stored procedure that can be used as an alternative way of inserting an employee record in the sample application.

	
Select the DatabaseNavigatorName tab to view the Database Navigator.


	
Expand the database connection node (by default called Connection1) to see the objects in the HR database.


	
Right-click Procedures, and select New Procedure.


	
In the Create PL/SQL Procedure dialog, enter insert_employee as the object name. Click OK.

The skeleton code for the procedure is displayed in the Source Editor.


	
After the keywords CREATE OR REPLACE, enter the following lines of code replacing the existing line:


PROCEDURE INSERT_EMPLOYEE (p_first_name  employees.first_name%type, 
  p_last_name    employees.last_name%type,
  p_email        employees.email%type,
  p_phone_number employees.phone_number%type,
  p_job_id       employees.job_id%type,
  p_salary       employees.salary%type
) 


	
After the BEGIN statement, replace the line that reads NULL with the following:


  INSERT INTO Employees VALUES (EMPLOYEES_SEQ.nextval, p_first_name, 
    p_last_name, p_email, p_phone_number, SYSDATE, p_job_id, 
    p_salary,.30, 100, 80);


You can see that the statement uses the same hard-coded values that are used for the last three columns in the addEmployee method in the DataHandler.java class.


	
Add the procedure name in the END statement:


END insert_employee;


	
Save the file, and check whether there are any compilation errors.




The complete code for the stored procedure is shown in Example 6-6.


Example 6-6 Creating a PL/SQL Stored Procedure to Insert Employee Data


CREATE OR REPLACE PROCEDURE INSERT_EMPLOYEE (p_first_name  employees.first_name%type, 
  p_last_name    employees.last_name%type,
  p_email        employees.email%type,
  p_phone_number employees.phone_number%type,
  p_job_id       employees.job_id%type,
  p_salary       employees.salary%type
) 
AS
BEGIN
  INSERT INTO Employees VALUES (EMPLOYEES_SEQ.nextval, p_first_name , 
    p_last_name , p_email , p_phone_number, SYSDATE, p_job_id, 
    p_salary,.30,100,80);
END insert_employee;








6.2.2 Creating a Method to Use the Stored Procedure

In these steps, you add a method to the DataHandler.java class that can be used as an alternative to the addEmployee method. The new method you add here makes use of the insert_employee stored procedure.

	
Select the Application tab to display the Application Navigator.


	
If the DataHandler.java file is not already open in the Java Source Editor, double-click it to open it.


	
Import the CallableStatement interface as follows:


import java.sql.CallableStatement;


	
After the addEmployee method, add the declaration for the addEmployeeSP method.


public String addEmployeeSP(String first_name, String last_name, 
  String email, String phone_number, String job_id,
  int salary) throws SQLException {
}


The method signature is the same as that for addEmployee.


	
Inside the method, add a try block, and inside that, connect to the database.


try {
  getDBConnection(); 
}


	
In addition, inside the try block, create the SQL string:


sqlString = "begin hr.insert_employee(?,?,?,?,?,?); end;";


The question marks (?) in the statement are bind variables, acting as placeholders for the values of first_name, last_name, and so on expected by the stored procedure.


	
Create the CallableStatement:


CallableStatement callstmt = conn.prepareCall(sqlString);


	
Set the IN parameters:


  callstmt.setString(1, first_name);
  callstmt.setString(2, last_name);
  callstmt.setString(3, email);
  callstmt.setString(4, phone_number);
  callstmt.setString(5, job_id);
  callstmt.setInt(6, salary);


	
Add a trace message, and run the callable statement.


  System.out.println("\nInserting with stored procedure: " + 
                      sqlString);
  callstmt.execute();


	
Add a return message:


  return "success"; 


	
After the try block, add a catch block to trap any errors. Call the logException created in Example 5-5.


catch ( SQLException ex ) {
  System.out.println("Possible source of error: Make sure you have created the stored procedure"); 
  logException( ex ); 
  return "failure";
}


	
Save DataHandler.java.




The complete method is shown in Example 6-7.




	
Note:

If you have not added the logException() method (see Example 5-5), JDeveloper will indicate an error by showing a red curly line under logException(ex). This method must be present in the DataHandler.java class before you proceed with compiling the file.








Example 6-7 Using PL/SQL Stored Procedures in Java


public String addEmployeeSP(String first_name, String last_name, 
  String email, String phone_number, String job_id,
  int salary) throws SQLException {
 
  try {
    getDBConnection(); 
    sqlString = "begin hr.insert_employee(?,?,?,?,?,?); end;";
    CallableStatement callstmt = conn.prepareCall(sqlString);
    callstmt.setString(1, first_name);
    callstmt.setString(2, last_name);
    callstmt.setString(3, email);
    callstmt.setString(4, phone_number);
    callstmt.setString(5, job_id);
    callstmt.setInt(6, salary);
    System.out.println("\nInserting with stored procedure: " + 
                       sqlString);
 
    callstmt.execute();
    return "success"; 
  }
  catch ( SQLException ex ) {
    System.out.println("Possible source of error: Make sure you have created the stored procedure"); 
    logException( ex ); 
    return "failure";
  }
}








6.2.3 Enabling Users to Choose the Stored Procedure

The steps in this section add a radio button group to the insert.jsp page, which enables a user to choose between inserting an employee record using the stored procedure, or by using a SQL query in Java code.

	
Open insert.jsp in the Visual Editor, if it is not already open.


	
Create a new line after the Insert Employee Record heading. With the cursor on this new line, drag UseBean from the JSP page of the Component Palette to add a jsp:useBean tag to the page. Enter empsbean as the ID, browse to select hr.DataHandler as the Class, and set the Scope to session. With the UseBean still selected on the page, set the style of this line to None instead of Heading 3.


	
Drag a Radio Button component from the HTML Forms page of the Component Palette onto the page inside the form above the table. In the Insert Radio Button dialog, enter useSP as the Name, false as the Value, and select Checked. Click OK.


	
In the Visual Editor, position the cursor to the right of the button, and enter text to describe the purpose of the button, for example, 'Use only JDBC to insert a new record'.


	
Press Enter at the end of the current line to create a new line.


	
Drag a second Radio Button below the first one. In the Insert Radio Button dialog, use useSP as the Name, true as the Value, and ensure that the Checked check box is not selected.


	
In the Visual Editor, position the cursor directly to the right of the button, and enter text to describe the purpose of the button, for example, 'Use stored procedure called via JDBC to insert a record'.


	
Save the page.




Figure 6-1 shows insert.jsp with the radio button that provides the option to use a stored procedure.


Figure 6-1 Adding a Link to Provide the Stored Procedure Option

[image: Description of Figure 6-1 follows]









6.2.4 Calling the Stored Procedure from the Application

The steps in this section modify the insert_action.jsp file, which processes the form on the insert.jsp page, to use the radio button selection and select the appropriate method for inserting a new employee record.

	
Open insert_action.jsp in the Visual Editor, if it is not already open.


	
Double-click the scriptlet to invoke the Scriptlet Properties dialog box and add a new variable after the salary variable, as follows:


String useSPFlag = request.getParameter("useSP");


	
Below that, still in the Scriptlet Properties dialog box, replace the existing empsbean.addEmployee line with the following lines of code to select the addEmployeeSP method or the pure JDBC addEmployee method to insert the record.


if ( useSPFlag.equalsIgnoreCase("true"))
  empsbean.addEmployeeSP(first_name, last_name, email, 
  phone_number, job_id, salary.intValue()); 
// otherwise use pure JDBC insert
else
  empsbean.addEmployee(first_name, last_name, email, 
  phone_number, job_id, salary.intValue()); 


	
Save insert_action.jsp.




You can now run the application and use the radio buttons on the insert page to choose how you want to insert the new employee record. In a browser, the page will appear as shown in Figure 6-2.


Figure 6-2 Using Stored Procedures to Enter Records

[image: Description of Figure 6-2 follows]











6.3 Using Cursor Variables

Oracle JDBC drivers support cursor variables with the REF CURSOR types, which are not a part of the JDBC standard. REF CURSOR types are supported as JDBC result sets.

A cursor variable holds the memory location of a query work area, rather than the contents of the area. Declaring a cursor variable creates a pointer. In SQL, a pointer has the data type REF x, where REF is short for REFERENCE and x represents the entity being referenced. A REF CURSOR, then, identifies a reference to a cursor variable. Many cursor variables may exist to point to many work areas, so REF CURSOR can be thought of as a category or data type specifier that identifies many different types of cursor variables. A REF CURSOR essentially encapsulates the results of a query.

Oracle does not return ResultSets. To access data returned by a query, you use CURSORS and REF CURSORS. CURSORS contain query results and metadata. A REF CURSOR (or CURSOR variable) data type contains a reference to a cursor. It can be passed between the RDBMS and the client, or between PL/SQL and Java in the database. It can also be returned from a query or a stored procedure.




	
Note:

REF CURSOR instances are not scrollable.







This section contains the following subsections:

	
Oracle REF CURSOR Type Category


	
Accessing REF CURSOR Data


	
Using REF CURSOR in the Sample Application






6.3.1 Oracle REF CURSOR Type Category

To create a cursor variable, begin by identifying a type that belongs to the REF CURSOR category. For example:


dept_cv DeptCursorTyp 
...


Then, create the cursor variable by declaring it to be of the type DeptCursorTyp:


Example 6-8 Declaring a REF CURSOR Type


DECLARE TYPE DeptCursorTyp IS REF CURSOR




REF CURSOR, then, is a category of data types, rather than a particular data type. Stored procedures can return cursor variables of the REF CURSOR category. This output is equivalent to a database cursor or a JDBC result set.






6.3.2 Accessing REF CURSOR Data

In Java, a REF CURSOR is materialized as a ResultSet object and can be accessed as follows:


Example 6-9 Accessing REF Cursor Data in Java


import oracle.jdbc.*;
...
CallableStatement cstmt;
ResultSet cursor;

// Use a PL/SQL block to open the cursor
cstmt = conn.prepareCall
         ("begin open ? for select ename from emp; end;");

cstmt.registerOutParameter(1, OracleTypes.CURSOR);
cstmt.execute();
cursor = ((OracleCallableStatement)cstmt).getCursor(1);

// Use the cursor like a normal ResultSet
while (cursor.next ())
    {System.out.println (cursor.getString(1));} 




In the preceding example:

	
A CallableStatement object is created by using the prepareCall method of the connection class.


	
The callable statement implements a PL/SQL procedure that returns a REF CURSOR.


	
As always, the output parameter of the callable statement must be registered to define its type. Use the type code OracleTypes.CURSOR for a REF CURSOR.


	
The callable statement is run, returning the REF CURSOR.


	
The CallableStatement object is cast to OracleCallableStatement to use the getCursor method, which is an Oracle extension to the standard JDBC application programming interface (API), and returns the REF CURSOR into a ResultSet object.









6.3.3 Using REF CURSOR in the Sample Application

In the following sections, you enhance the sample application to display a dynamically-generated list of job IDs and job titles in the Job field when they are inserting a new employee record.

	
Creating a Package in the Database


	
Creating a Database Function


	
Calling the REF CURSOR from a Method


	
Displaying a Dynamically Generated List




To do this, you create a database function, GET_JOBS, that uses a REF CURSOR to retrieve a result set of jobs from the Jobs table. A new Java method, getJobs, calls this database function to retrieve the result set.



6.3.3.1 Creating a Package in the Database

The following steps create a new package in the database to hold a REF CURSOR declaration.

	
Select the DatabaseNavigatorName tab to view it in the Navigator.


	
Expand the Connection1 node to view the list of database objects. Scroll down to Packages. Right-click Packages and select New Package.


	
In the Create PL/SQL Package dialog, enter JOBSPKG as the name. Click OK. The package definition is displayed in the Source Editor.


	
Replace the line /* TODO enter package declarations (types, exceptions, methods etc) here */ with the following line, to declare a REF CURSOR as follows:


    TYPE ref_cursor IS REF CURSOR;


	
Save the package.




The code for the package is shown in Example 6-10:


Example 6-10 Creating a Package in the Database


CREATE OR REPLACE
PACKAGE JOBSPKG AS
    TYPE ref_cursor IS REF CURSOR;
END;








6.3.3.2 Creating a Database Function

These steps create a database function GET_JOBS that uses a REF CURSOR to retrieve a result set of jobs from the Jobs table.

	
In the Database Navigator, again expand the necessary nodes to view the objects in the HR database. Right-click Functions and select New Function from the shortcut menu.


	
In the Create PL/SQL Function dialog, enter GET_JOBS as the name. Click OK. The definition for the GET_JOBS function displays in the Source Editor


	
In the first line of the function definition, substitute JobsPkg.ref_cursor as the return value, in place of VARCHAR2.


	
After the AS keyword, enter the following:


 jobs_cursor JobsPkg.ref_cursor;


	
In the BEGIN block enter the following code to replace the current content:


  OPEN jobs_cursor FOR
  SELECT job_id, job_title FROM jobs;
  RETURN jobs_cursor;


	
Save the function




The code for the function is shown in Example 6-11.


Example 6-11 Creating a Stored Function


CREATE OR REPLACE FUNCTION GET_JOBS
RETURN JobsPkg.ref_cursor
AS jobs_cursor JobsPkg.ref_cursor;
BEGIN
  OPEN jobs_cursor FOR
  SELECT job_id, job_title FROM jobs;
  RETURN jobs_cursor;
END;








6.3.3.3 Calling the REF CURSOR from a Method

These steps create a Java method, getJobs, in the DataHandler class that calls the GET_JOBS function to retrieve the result set.

	
Double-click DataHandler.java to open it in the Source Editor if it is not already open.


	
Enter the method declaration.


public ResultSet getJobs() throws SQLException {
 
}


	
Within the method body, connect to the database.


  getDBConnection();


	
Following the connection, declare a new variable, jobquery:


  String jobquery = "begin ? := get_jobs; end;";


	
Create a CallableStatement using the prepareCall method:


  CallableStatement callStmt = conn.prepareCall(jobquery);


	
Register the type of the OUT parameter, using an Oracle-specific type.


  callStmt.registerOutParameter(1, OracleTypes.CURSOR);


	
When you specify that you want to use an Oracle-specific type, JDeveloper displays a message asking you to use Alt+Enter to import oracle.jdbc.OracleTypes. Press Alt+Enter, and then select OracleTypes (oracle.jdbc) from the list that appears.


	
Run the statement and return the result set.


  callStmt.execute();
  rset = (ResultSet)callStmt.getObject(1);


	
Enclose the code entered so far in a try block.


	
Add a catch block to catch any exceptions, and call your logException method as well.


catch ( SQLException ex ) {
  logException( ex );
}


	
After the close of the catch block, return the result set.


return rset;


	
Make the file to check for syntax errors.




The code for the getJobs method is as follows:


  public ResultSet getJobs() throws SQLException {
  try {
    getDBConnection();
    String jobquery = "begin ? := get_jobs; end;";
    CallableStatement callStmt = conn.prepareCall(jobquery);
    callStmt.registerOutParameter(1, OracleTypes.CURSOR);
    callStmt.execute();
    rset = (ResultSet)callStmt.getObject(1);
  } catch ( SQLException ex ) {
  logException( ex );
  }
  return rset;
  }






6.3.3.4 Displaying a Dynamically Generated List

To create the list displaying the list of job IDs and job titles in the Insert page, you hard-coded the job IDs and job titles. In the following steps, you replace this with a dynamically-generated list provided by the REF CURSOR created in the previous section.

	
Double-click insert.jsp in the Application Navigator to open it in the Visual Editor, if it is not already open.


	
Click and select the Page Directive on the top left corner of the page. The Property Inspector now shows the properties of the Page Directive.


	
Click the down arrow next to the Import field. The Edit Property: Import dialog box is displayed. Select the Hierarchy tab and then select ResultSet after extending Java and SQL folders respectively. Click OK.


	
Drag a scriptlet onto the page next to the Page Directive. In the Insert Scriptlet dialog box, add the following code to execute the getJobs method and return a result set containing a list of jobs.


ResultSet rset = empsbean.getJobs();


	
Select the ListBox component in the page (the component to enter the job in the form), and click Scriptlet in the JSP Component Palette. (You need not drag and drop the scriptlet onto the page in this case.) The Insert Scriptlet dialog box appears.


	
Enter the following code into the Insert Scriptlet dialog box. Click OK.


  while (rset.next ())
   {
    out.println("<option value=" + rset.getString("job_id") + ">" + 
    rset.getString("job_title") + "</option> "  );
   }


	
Remove the hard-coded values as follows.

With the ListBox component still selected, in the Structure window scroll to Job field. Examine the list of hard-coded options below the select keyword. Delete each of the options, ensuring that you retain the scriptlet.


Figure 6-3 Structure View of ListBox Options

[image: Description of Figure 6-3 follows]





	
Save the page.




Now run the application, click to insert a new employee and use the list to display a list of available jobs. Figure 6-4 shows the dynamic jobs list in the browser.


Figure 6-4 Dynamically Generated List in Browser

[image: Description of Figure 6-4 follows]



















7 Getting Unconnected from Oracle Database XE

While unconnecting from the database in JDeveloper is a simple task, it is not a process by itself in a Java application. In the application, you must explicitly close all ResultSet, Statement, and Connection objects after you are through using them. When you close the Connection object, you are unconnected from the database. The close methods clean up memory and release database cursors. Therefore, if you do not explicitly close ResultSet and Statement objects, serious memory leaks may occur, and you may run out of cursors in the database. You must then close the connection.

This chapter includes the following sections:

	
Creating a Method to Close All Open Objects


	
Closing Open Objects in the Application






7.1 Creating a Method to Close All Open Objects

The following steps add a closeAll method to the DataHandler class:

	
Open DataHandler.java in the Java Source Editor by double-clicking it in the Application Navigator.


	
Declare the closeAll method at the end of the DataHandler class as follows:


public void closeAll() {
 
} 


	
Within the method body, check whether the ResultSet object is open as follows:


if ( rset != null ) {


	
If it is open, close it and handle any exceptions as follows:


  try { rset.close(); } catch ( Exception ex ) {} 
  rset = null;
} 


	
Repeat the same actions with the Statement object.


if ( stmt != null ) {
  try { stmt.close(); } catch ( Exception ex ) {} 
  stmt = null;
}


	
Finally, close the Connection object.


if ( conn != null ) {
  try { conn.close(); } catch ( Exception ex ) {} 
  conn = null;
}




The complete closeAll method should look similar to that shown in Example 7-1.


Example 7-1 Creating a Method to Close All Open Objects


public void closeAll() {
  
  if ( rset != null ) {
    try { rset.close(); 
    } 
    catch ( Exception ex ) {} 
  rset = null;
  }
  
  if ( stmt != null ) {
  try { 
      stmt.close();
  }
  catch ( Exception ex ) {} 
  stmt = null;
  }
  
  if ( conn != null ) {
  try { 
      conn.close(); 
      } 
   catch ( Exception ex ) {} 
conn = null;
  }
 } 








7.2 Closing Open Objects in the Application

You must close the ResultSet, Statement, and Connection objects only after you have finished using them. In the DataHandler class, the insert, update, and delete methods must close these objects before returning. Note that the query methods cannot close these objects until the employees.jsp page has finished processing the rows returned by the query.

In the following steps, you add the appropriate calls to the closeAll method in the DataHandler.java file:

	
Open DataHandler.java in the Java Source Editor.


	
At the end of the addEmployee method, after the closing brace of the catch block, add the following call to the closeAll method in a finally block:


finally {
  closeAll();
}


	
Add the same call to the addEmployeeSP, deleteEmployeeById, findEmployeeById, updateEmployee, and authenticateUser methods.


	
Open the employees.jsp file in the Visual Editor. Find the scriptlet inside the Employees table, and double-click to open the Insert Scriptlet dialog box.


	
Add the following statement after the while loop:


empsbean.closeAll();


	
Save your work, and compile and run the application to ensure that everything still works correctly.















8 Creating a Universal Connection Pool

A connection pool is a cache of database connection objects. The objects represent physical database connections that can be used by an application to connect to a database. At run time, the application requests a connection from the pool. If the pool contains a connection that can satisfy the request, it returns the connection to the application. If no connections are found, a new connection is created and returned to the application. The application uses the connection to perform some work on the database and then returns the object back to the pool. The connection is then available for the next connection request.

Universal Connection Pool (UCP) for JDBC provides a connection pool implementation for caching JDBC connections. Java applications that are database-intensive use the connection pool to improve performance and better utilize system resources. A UCP JDBC connection pool can use any JDBC driver to create physical connections that are then maintained by the pool. The pool can be configured and provides a full set of properties that are used to optimize pool behavior based on the performance and availability requirements of an application. For more advanced applications, UCP for JDBC provides a pool manager that can be used to manage a pool instance.




	
See Also:

Oracle Universal Connection Pool for JDBC Developer's Guide







This chapter describes how to create a Universal Connection Pool. This chapter has the following sections:

	
Setting JDeveloper Project Properties


	
Creating the Stock Ticker Application


	
Observing the Output






8.1 Setting JDeveloper Project Properties

To create a Universal Connection Pool, first you must set JDeveloper project properties by performing the following steps:

	
From the Application menu, select Default Project Properties.


Figure 8-1 Setting the Default Project Properties

[image: Description of Figure 8-1 follows]





	
Click Libraries and Classpath on the left panel of the Default Project Properties screen.


Figure 8-2 Setting the Libraries and Classpath

[image: Description of Figure 8-2 follows]





	
Click Add JAR/ Directory on the right pane of the Default Project Properties screen.

The Add Archive or Directory screen is displayed.


	
Select ucp.jar file in the $ORACLE_HOME/ucp/lib folder and click Select.


Figure 8-3 The Add Archive or Directory Screen

[image: This image illustrates how to add a jar to the classpath.]



	
Click OK.









8.2 Creating the Stock Ticker Application

The following example is a stock ticker application that uses the Universal Connection Pool to retrieve stock price information from the database. Using this example, you can view the Universal Connection Pool properties, change the properties at run time without shutting down the pool instance, view Universal Connection Statistics and so on. Perform the following steps to run the example:

	
Click New Application in the Application Navigator panel.


Figure 8-4 The Application Navigator Panel Options

[image: This image illustrates how to create a new application.]



	
Enter StockTickerApp as the Application Name in the Name Your Application screen and click Next.


	
Enter StockTickerProj as the Project Name in the Name Your Project screen and click Finish.


	
Click Open from File menu.


	
Select the UCPDemo.java, ClientSimulator.java, DBConfig.java, HttpServer.java, and DbConfig.properties files and click Open.


	
In the DbConfig.properties file, verify the information about the user name, the password, and the URL of your Oracle database.


Figure 8-5 The DbConfig.properties File in the Code Editor

[image: This image illustrates the content of the DBConfig file.]



	
Right-click the UCPDemo.java tab in the code editor and select Add to StockTickerProj.jpr.


Figure 8-6 Adding a Source File to a Project

[image: This image illustrates how to add a file to a project.]



	
Retain the default value for the content path in the Add to Project Content screen and click OK.


Figure 8-7 The Add to Project Content

[image: This image illustrates how to add a file to a project.]



	
Repeat steps 7 and 8 for ClientSimulator.java, DBConfig.java, HttpServer.java, and DbConfig.properties files to add them to the StockTickerProj project.


	
Right-click the UCPDemo.java file in the Application Navigator window and click Make.


	
Select Choose Active Run Configuration from the Run menu and then select Manage Run Configurations.


Figure 8-8 The Run Menu Options

[image: Description of Figure 8-8 follows]





	
Click Edit in the Project Properties screen for the StockTickerProj project.


Figure 8-9 The Project Properties Screen for the StockTickerProj Project

[image: Description of Figure 8-9 follows]





The Edit Run Configuration screen is displayed.


	
Enter 8067 or any free port on your system in the Program Arguments field and click OK.


Figure 8-10 The Edit Run Configuration Screen

[image: Description of Figure 8-10 follows]





	
Click OK to exit the Project Properties screen.


	
Right-click the UCPDemo.java file in the Application Navigator window and click Run.









8.3 Observing the Output

When you run the application, initially it will spend a few seconds to store the stock price data into the database. So, wait until the message "...ready to go!" is printed out on the screen as shown in Figure 8-11.


Figure 8-11 Output of the Stock Ticker Application in JDeveloper Log

[image: This image shows the output of the stock sticker demo]



After the message is displayed, the UCP demo server is up and running and you can use it by using the following steps:

	
Enter the following URL in the address bar of your browser:

http://localhost:8067

The Universal Connection Pool Demo page is displayed.


Figure 8-12 Retrieving Information from the Universal Connection Pool Using the Browser

[image: This image describes the UCP options on the browser]



	
Click the links below the Try the Demo: section to retrieve stock price information from the database.

Click Show UCP Properties to see the UCP properties:


Figure 8-13 The UCP Properties page

[image: Description of Figure 8-13 follows]





Click Get Stock Price from Database to run the stock ticker:


Figure 8-14 The Stock Ticker Page on the Browser

[image: Description of Figure 8-14 follows]





Click Show UCP Statistics to see the UCP statistics:


Figure 8-15 The UCP Statistics Page on the Browser

[image: Description of Figure 8-15 follows]





Click Dynamically Reconfigure UCP Properties to update the UCP properties:




	
Note:

You can change the UCP properties in the browser by clicking the Dynamically Reconfigure UCP Properties link. However, if you try to set a property that is not relevant for a single instance Database, then an exception may be thrown.








Figure 8-16 The UCP Properties Update Page on the Browser

[image: Description of Figure 8-16 follows]





Click Run Massive Website Client Access Simulation to simulate many stock ticker clients using the service simultaneously:


Figure 8-17 The Client Simulator Page on the Browser

[image: Description of Figure 8-17 follows]





This page provides the following fields:

Ticket server URL: specifies the URL of ticker web service

Number of simulated users (threads) to run: specifies the number of concurrent threads to run

Number of ticket requests per user: specifies number of ticker requests per thread to run
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